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Getting Started

Step 1: The Interface

When you start Multiquence, a single blank track appears as shown in the diagram.

Figure 1: Track Window

The Track volume slider controls the volume for the track.    Moving the control up increase the volume.    
Both the Master volume and Track volume apply only to digital audio sections and do not affect the 
volume of MIDI or CD audio sections.    You can use the Windows Volume Control accessory to change 
the volumes for those devices.

The Time line shows what region of the project is currently displayed in the window.    Moving the mouse 
arrow within this area displays the exact time in the status bar.    Clicking the left mouse button here will 
move the marker.    A time context menu appears if you click the right mouse button here.

The Mute button disables a track so that it is not mixed or played.    All the other tracks are played.    You 
can use the mute button to temporarily remove a track from playback.    The Solo button does the 
opposite.    Only one track is played; no other tracks are mixed or played.    This lets you hear a single 
track when working with many tracks.

The marker is used for several editing commands and for starting playback at a specific time.    It can be 
moved by clicking the left mouse button in the Time line or by clicking the right mouse button on a section 
and using the Move marker here command.

Section space is the area where sections are placed on a track (as shown below).    Each section has a 
name (usually a filename), a start time and an end time.    The selected track and section have a blue 
border.    All new sections are added to the selected track and any editing is performed on the selected 
section. You can use the left mouse button to select a different track or section.



Figure 2: Sections

If a section extends outside the view, a black arrow appears on the end of the section, as shown.

Figure 3: Master Control

The Master Control window contains all the playback controls and the video window.    The top right 
corner has several size buttons for changing the size of the Master Control window and the video aspect 
ratio.    The ratios are 4 to 3 for standard television and 16 to 9 for high definition television.

The volume slider controls the final mixing and playback volume level for all of the tracks.    If you received 
any "clipping" warnings the volume needs to be decreased.

Just above the master volume slider are left and right VU meters (with left on the top) that indicate the 
output volume level of all the tracks combined.    If the maximum level is exceeded, meaning that clipping 
is required, the right-most red light will remain lit.

Step 2: Setup

The first thing you should do is to set all the folders using the Options | Folder command.    These folders 
are used whenever you add a file to a track.    Set the "Audio" folder to the place where you keep all your 
.wav files.    Set the "Project" folder to the place where you want to save your Multiquence projects.

If you have an audio editor, such as GoldWave, you can specify its full filename in the "Digital audio 
editor" box.    Multiquence will run the editor when you use the Edit | Open editor command.

Check that an appropriate sound card has been selected for output under Options | Playback.    The 
"Microsoft Sound Mapper" is selected by default, which is fine if you only have one sound card.    If you 
have more than one card, you may want to select a specific driver.    If you are using an older 
SoundBlaster card, make sure the Reserve 16-bit recording option is enabled.

Step 3: Adding a File



There are several ways to add a file to a track:
· Choose an Add command from the Track menu.
· Choose the plus button in the tool bar.
· Click the right mouse button on the track and select the Add section command from the track 

context menu.
· Drag-and-drop a file (or set of files) from Windows Explorer.

Files are added in the selected track at the marker's position.    If there is no room for the files, they are 
added to the end of the selected track.

If you are adding a variety of small and large sections, you may need to zoom in or out to get a better 
view.    See View Menu Commands for details.

To see the contents of a file, such as the waveform for an audio section or images for a video section, you 
may need to zoom in.    Try the View | 10 seconds command.    Displaying of contents depends on the 
contents threshold setting.    Waveforms are not displayed for compressed audio files such as MP3 or 
WMA.

Step 4: Selecting and Moving sections

To select a single section, simply click the left mouse button on the section.    To select a group of 
sections, you can do one of the following:

· Click-and-drag using the right mouse button to select all the sections within a rectangular area. 
· Hold down the Ctrl key and click the left mouse button on each section you want to select (or 

unselect).
· Use the Edit | Group list command to select a previously assigned group.

To move a section, click and hold the left mouse button on a section, then drag-and-drop the section to a 
new time or to a different track.    If more than one section is selected, all selected sections are moved as 
a single group.    This preserves the relative spacing between all selected units.

To move a section to an exact time, right click on a section and choose the Move section command.    The 
Edit | Move command does the same thing for the currently selected section.    Note that when moving a 
group of sections, the time is always relative to the left-most section (the one that is played first).

Step 5: Playing a Project

The Playback menu and the Master Control window contain a number of commands for playing your 
project.    If you need to start playback from a specific time, click the left mouse button on the time (in the 
Time line area) and then choose the Playback | From marker command.    Although you cannot pause 
playback, you can use the Playback | Move marker command, then stop playback and later continue 
playback from the marker.

Step 6: Recording

To record in Multiquence, you must have either a full duplex 16-bit stereo sound card or more than one 
sound card installed in your system.

The View | Window | Recorder command displays the Recorder window where you can record new 
audio files.

If you need to synchronize recording with existing audio, such as recording vocals to background music, 
use the Track | Create recording section command to specify the filename, length, and number of 
channels for the new recording.    The recording section must be in a different track so that it overlaps the 



background music.    When you play the project, the background music is played and audio is recorded in 
the recording section.    To play the project after recording, use section options (described next) to set the 
recording section to Play mode.

Step 7: Setting Section Options

Different types of sections support different options.    An audio section has options for looping and 
input/output channel control. A video section has options for window position and size.

There are several ways to view these options:
· Double click the left mouse button on the section.
· Click the right mouse button on the section and select the Section options command from the 

section context menu.
· Make sure the sections is selected, then choose Section from the Options menu.

Step 8: Editing Sections

As mentioned above, you can drag-and-drop sections to any position or track using the left mouse button. 
If you are dragging a single section and there is not enough room for the section at the drop position, all 
of the sections following the drop position will be shifted to the right to make room.    A special mouse 
cursor appears if shifting is required.    When dragging a group, it can be dropped only if there is room for 
all sections.

Before using Edit Menu Commands, make sure the correct section is selected and has a blue border.    
Most editing commands apply only to the selected section.    For the example given in Figure 2 (above), 
editing modifies only the sound2.wav section.    If you wanted to edit sound1.wav instead, you would 
select that section with the mouse and move the marker to a point inside the section.

You can copy, trim, and split most sections using Edit Menu Commands.    In general, recording sections 
cannot be edited.    Note that only one section may be selected for some of the commands.

The copy and paste commands can be used to copy groups of sections from one project to another.

If a section has to be played in several places on several different tracks, you can make copies of the 
section and drag-and-drop them to a new position or track.

If you want to remove part of a section, you can move the marker to the point where it should be trimmed, 
then use the appropriate trim command.

If you need to insert a section in the middle of another section or you want to move part of a section to 
another track, you can move the marker to the dividing point and split it.

For audio sections, you can apply a variety of effects, such as flange, parametric EQ, dymanic volumes, 
and speed (see Crossfade for an example).    Video sections support fades and transform plug-ins.

Multiquence does not modify the original file (except when recording).    All editing and effects are 
performed realtime (on-the-fly) during playback. To modify a digital audio file, use Edit | Open editor.

Step 9: Saving a Project

The File | Save command saves the names and positions of all the files used in a project.    Note that if 
you change any of the files, it may alter the way the project plays the next time you open it.    Warning 
messages will be displayed if there are any problems.

The File | Save as wave command mixes all the digital audio sections and tracks into a single wave file.    



This file can then be played by other applications or burned onto a CD.    The playback rate of the wave 
file depends on the high/medium/low setting in Options | Playback.    For CD quality, make sure you have 
the High (44100 Hz) option selected. Note that only digital audio sections are mixed to the file.    MIDI, CD 
audio and video sections are not mixed.

If your system is not fast enough to play all the tracks, you can use the Save as wave command to 
combine several tracks into one.    By muting all the tracks you do not want to save, you can combine the 
remaining tracks into a wave file.    This file can then be added to the project to replace those tracks.

The File | Save as video command mixes all the video and audio tracks into a single AVI file.



A full duplex sound card is one that can record and play at the same time.    When you play a project, 
Multiquence uses the card for stereo, 16-bit digital audio playback.    If you have a recording section in the 
project, the same card is used for recording as well.    If your card is not full duplex, an error message is 
displayed.



Projects, Tracks, Groups and Sections

Sections

A section is the most basic unit within Multiquence.    It can be a digital audio file, a MIDI file, a video clip, 
or a section of audio from a CD. Each kind of section has its own colour.

Section Colours

The contents of a digital audio file can be seen graphically when zoomed in.    For a stereo sound, 
Multiquence uses a unique graph where the left channel is show in green on the top and the right channel 
is shown in red on the bottom.    Any effects enabled for the section, such as pan or flange, are indicated 
by effects flags.    The flags, in the order shown below, are flange, equalizer, pan, volume, and speed.

Digital Audio Section

Groups

When more than one section is selected, it is referred to as a group.    Some commands affect all sections 
in the group, such as    Move and Copy.    The    Edit | Group list command allows you to    create named 
groups, which can be used to quickly select a    specific group of sections.

Tracks

A track contains a sequence of sections that are played one after the other.    All tracks are played 
concurrently, or in other words, they all play at the same time.    This lets you play several digital audio 
files at once, provided you put each file on a different track.    For example, you can put music in one track 
and vocals in another and play it to see how they sound together.    For fun, you could put a video clip of 
the President on one track and an audio clip of Daffy Duck on another.

Projects

A project contains a combination of tracks and sections to create such things as music, audio CDs, radio 
programs and multimedia presentations.    They can store all the sounds necessary to play a short 30 
second radio commercial or a long two hour movie sound track. Up to 5 hours worth of material can be 
added.

It is important to remember that a project uses all the files you've added to it.    If you delete or modify any 



of those files, it may adversely affect your project the next time you open or play it.



Video Editing Basics

Video Layers

Multiquence supports an unlimited number of video layers.    Each track can be considered a single video 
layer.    These layers are drawn in the order the tracks appear on screen.    Video in Track 1 is drawn first, 
then video in Track 2 is drawn next, on top of Track 1, then video in Track 3 is drawn on top of that, and 
so on.    This means that the last track is always drawn on top of all other tracks.

It is important to remember this layering order when adding new video sections to a project.    For 
example, say you wanted Movie1 to appear as a picture-in-picture in Movie2.    You would first use the 
video section options to change the size of Movie1.    If you add the sections in the track order shown 
below, Movie1 will not be seen.

Wrong Layer Order

Video in Track 1 is drawn first, then video in Track 2 is drawn on top of it.    In this case, Movie2 will 
completely cover Movie1.

To correct the problem, simply drag-and-drop Track 1 below Track 2.

Correct Layer Order

Video in Track 2 is drawn first, then the video in Track 1 is drawn on top of it.    Since Movie1 was resized 
to be a smaller picture-in-picture, it will cover only a small part of Movie2.

Layering must be considered when using transform plug-ins and fading.    In most cases, the section 
being faded or transformed should be placed in the last track.

Transforms

The Effect | Video plug-ins command displays a list of all video transform plug-ins installed in your 
system.    Transforms can either modify the video in some way, such as making it appear blurred, or 
perform a transition from one video to another, such as a wipe or crossfade.

Transforms that perform a transition usually allow you to specify start and finish values.    These values 
determine the progress of the transition.    A value of 0 indicates no progress and a value of 1 indicates full 
progress.    As the video plays, Multiquence counts the progress from the start value to the finish value.

If a wipe transform is being used on Movie1, for example, and the start value is 0.5 and the finish value is 
1, Movie1 will initially appear as half wiped and then continue to become fully wiped out.    Progress can 



move backwards as well.    If start is 1 and finish is 0, then Movie1 will start completely wiped out, then 
gradually wipe in.    To really understand how all this works, you will need to experiment with the wipe 
transform. If a picture is worth a thousand words, then experience is worth a million.

In most cases, you will want the transform to complete long before the end of the section.    To do that, 
you need to split the section, then apply the transform to the beginning section.

Transition Wipe In

For a wipe transform, enable the wipe effect on the left section of Movie2 shown above, and set start to 1 
and finish to 0.    When the project is played, Movie1 starts playing, then Movie2 is wiped in and continues 
to play.

Transition Wipe Out

A similar effect is achieved by splitting the end of Movie1 and applying the transform to the end (right) 
section.    Note the layer change.    In this case, set start to 0 and finish to 1.    When the project is played, 
Movie1 starts playing, then Movie1 is wiped out and Movie2 is wiped in.

See Also
Crossfade Video
Using Plug-ins



A wipe transform wipes out the top video layer to reveal the lower layers.    It is like wiping a rag across a 
steamed up window.



Developer

GoldWave Incorporated is a Canadian corporation founded in 2001 by Chris Craig after 7 years of 
independent software development.    The company's goal is to provide high quality, inexpensive, and 
easy to use digital audio and video tools.

Contact Information

Mail:
GoldWave Inc. 
P.O. Box 51 
St. John's, NF 
CANADA    A1C 5H5 

Websites: 
Company:     http://www.goldwave.com/ 
Multiquence: http://www.goldwave.com/multiquence/ 
Contact:     http://www.goldwave.com/multiquence/contact.html 



File Menu Commands

New
Creates a new project with a single blank track.    If another project was opened, you are asked to save 
any changes.

Open
Opens an existing project.    After the file is opened, all the sections in the project are checked to 
determine if they have been modified.    If any changes are found, warning messages will be displayed.    
Note that if a file cannot be found, the folders specified in Options | Folder are searched.

Save
Saves the project to the disk.    The names and positions of all of the files used in the project are saved.    
Note that any changes made to those files may change the project the next time it is opened.

Save as
Saves the project to the disk under a different name.

Save as wave
Combines and mixes all digital audio portions of a project into a single wave file.    Only digital audio 
sections are mixed.    MIDI and CD audio sections are not included.

The sampling rate of the file is determined by the Options | Playback setting.    For best quality, make sure 
to use the High (44100 Hz) setting.

Save as video
Combines and mixes all digital video and audio portions of a project into a single AVI file.    See Save as 
wave above for details.    Note that not all video codecs work and some use a fixed size for the image.

Exit
Exits Multiquence.



Edit Menu Commands

Before using some of these edit commands, make sure the correct section is selected.    Some command 
require that only one section is selected. See Getting Started.

Undo
Reverses the last modification.

Open editor
Runs the audio editing application specified in Options | Folder.

Cut
Copies the selected sections to the clipboard and removes them.

Copy
Makes a copy of the selected sections on the clipboard.

Paste at marker
Pastes the sections in the clipboard into the selected track at the marker's position.    If there is no room 
for the sections, they are pasted at the end of the track.    All relative track and section spacing is 
preserved.

Mute
Disables the selected sections so that they will not be mixed or played.    Use this command to see how 
the project sounds without the selected sections.

Move
Moves selected sections to an exact time.

Split
Divides the selected section at the marker's position.    Use this command to insert a section in the middle 
of the selected section or to move part of a section to another track.

Trim beginning
Removes the beginning of the selected section up to the marker's position.    Use this command to keep 
the last 20 seconds of a 30 second file, for example.

Trim end
Removes the end of the selected section at the marker's position.    The part of the section extending from 
the marker's position to the end of the section is trimmed.    Use this command to keep the first 20 
seconds of a 30 second file, for example.

Delete
Removes all selected sections from the project.

Group list
Manages, creates, deletes, or selects groups.

Set marker
Moves the marker to an exact time.

Find section
Searches all tracks to find a selection of a given name.

Find next



Searches all tracks to find the next section with the given name.

See Also
Getting Started
Section Options



Effect Menu Commands

Flange
Adds a flange effect to the selected audio section.    Flange effects cannot be added to CD, MIDI, or video 
sections.

Equalizer
Applys a parametric equalizer to the selected audio section.    Equalizers cannot be applied to CD, MIDI, 
or video sections.

Speed
Sets the playback speed of the selected audio section.    Changing the speed also changes the pitch of 
the sound.    Speed cannot be applied to CD, MIDI, video, or recording sections.

Autofade
Automatically creates fade envelopes for all sections in the selected track based on the positions of the 
selected sections.    To use this command, select the sections that should remain loud, then select a track 
that contains background audio.    Note that none of the loud sections can be in the track you select.

Fade graph
Shows or hides dynamic fades for all audio and video sections.    By clicking the left mouse button inside 
a section, you can add or move points to change the fade envelope.    Dragging a point outside the 
section will remove it.    See Crossfade Audio and Crossfade Video for examples.

Pan graph
Shows or hides dynamic panning for all audio sections.    By clicking the left mouse button inside a 
section, you can add or move points to change the fade envelope.    Dragging a point outside the section 
will remove it.    The higher the point, the more left the balance will be.    The lower the point, the more 
right it will be.

Reset fade
Resets the fade envelope to a straight line for the selected sections.

Reset pan
Resets the panning envelope to a straight line (center) for the selected audio sections.

Audio plug-ins
Displays a list of plug-ins installed in the system.    Audio plug-ins include effects such as reverb, noise 
gate, equalizers, and so on.

Video plug-ins
Displays a list of video transform plug-ins installed in the system.    Video plug-ins include transitions such 
as wipe, fade, and pixelate and effects such as blur, emboss, and engrave.

See Also
Getting Started
Section Options



Track Menu Commands

Track menu commands create new tracks, add files (sections) to the selected track, delete a track, or find 
a section.    When possible, new sections are added at the marker's position, otherwise they are added to 
the end of the track.

New
Creates a new blank track.

Move up and Move down
Moves the selected track up or down in the list.    This lets you arrange the order of tracks.

Add section
Adds a file to the selected track.    The file can be audio, MIDI, or video.    All supported files types are 
listed.

Add audio section
Adds an audio file.    Only digital audio files are listed.

Add MIDI section
Adds a MIDI file.    Only MIDI files are listed.

Add CD section
Adds a CD audio section.    Before using this command, make sure an audio CD is inserted in your CD-
ROM drive.

Add video section
Adds a video section.

Add image section
Adds a still image section.

Add caption section
Adds a text caption section.

Create recording section
Creates a file for recording and adds it to the selected track.    When you play a project, the section record 
digital audio from your sound card.    The recording section can be set to playback mode using section 
options.

Delete track
Deletes the selected track and all sections.



View Menu Commands

View commands act like a zoom lens allowing you to zoom in and out of the project.    By using these 
commands, you can get a more detailed view of individual sections or of the overall project.    To quickly 
zoom in and out, use the up and down arrow keys.

Beginning of section and End of section
Moves the view to the beginning or end of the selected section.    Use these commands to quickly see the 
previous or next section when zoomed in.

End of track
Moves the view to the end of the selected track.

Marker
Moves the view to the marker if you are zoomed in and the marker is outside the view.

Size
Changes the vertical size of all tracks.    When set to small, more tracks are shown, which is useful when 
moving a groups of sections.    When set to large, it shows much more detail in the sections and allows 
fade and pan envelopes to be set more precisely.

Zoom in and Zoom out
Zoom in expands the time line showing more detail.    Zoom out compresses the time line showing less 
detail, but more of the overall project.

All
Displays the entire project.

1 second
Displays one second of the project.    At this level, you can easily see small sections and perform accurate 
editing.

10 seconds
Displays ten seconds of the project.    This level is useful for setting volume levels or manipulating small 
sections.

1 minute
Displays one minute of the project.    This level give you a good overview of short projects.

5 minutes
Displays five minute of the project.    You can arrange large sections at this level.

1 hour
Displays 1 hour of the project, which is useful for CD audio projects.

Window
The Window menu holds commands to show or hide the Messages window, the Project list window, 
open a Recorder window or an XML window.    The Project list window lists all tracks and sections in a 
project and allows sections names to be changed.    The XML window shows a project listing in XML 
format that can be saved to a file.

Show contents
Displays or hides waveform graphs for audio sections or images for video sections.    Contents are 
displayed only if the amount of time shown in the view is less than or equal to the Contents threshold.



Contents threshold
Sets the time threshold for displaying waveforms or images inside sections.

Snap to zero-crossing
Snaps the marker to the closest zero-crossing.    When moving the marker, the marker will be placed at a 
point where the audio level crosses zero amplitude.    When trimming or splitting an audio section, it is 
best to enable this option to prevent a pop or click caused by sudden changes in amplitude.    This feature 
ensures that amplitudes at the edit point will always be as close to zero as possible.

Note: The marker is adjusted only for the one selected audio section in the selected track.    If you select 
a different audio section, click the left mouse button on the marker to find the new zero-crossing.    This 
only works well for uncompressed audio, not MP3 or WMA    files.

Grid/snap to grid
Displays a grid and snaps the marker to the grid.    When dragging a section, the starting point of the 
section is snapped to a grid line.    The grid is visible only if the space between each line can be shown, 
otherwise you will need to zoom in to see the grid.

Grid size
Sets the grid spacing.



Playback Menu Commands

All
Plays the entire project.

From marker to end
Starts playback at the marker's position and plays to the end of the project.

View
Plays the section of the project shown in the view.

From marker
Plays the section of the project shown in the view starting at the marker's position.

To marker
Plays the section of the project shown in the view and stops at the marker's position.    The marker must 
be visible.

Stop
Stops playback.

Move marker
Moves the marker to the current playback position.    Use this command when you need to mark a place 
to trim or split a section.



Options Menu Commands

Section
Presents a dialog where section options can be changed for the selected section.    Different types of 
sections have different options.    Select one of the following: Audio, CD audio, MIDI, Recording, Image, 
Caption, or Video.

Track
Presents a dialog where the selected track name and settings can be changed.

Folder
Presents a dialog where folders for various types of files can be specified.

Playback
Presents a dialog where playback features can be configured.

Tool bar
Presents a dialog where the tool bar can be configured.



Keyboard Commands

General

Keystroke Action
F1 Starts help.
F3 Find next section.
Ctrl+G Show or hide grid and enable or disable 

snap-to-grid.
Ctrl+O Open project.
Ctrl+W Show or hide waveforms or images.
Tab Move to marker position.
Enter Section options.
Up Zoom in.
Down Zoom out.
Ctrl+Up Select track above the currently selected 

track.
Ctrl+Down Select track below the currently selected 

track.
Alt+Up Move selected track up.
Alt+Down Move selected track down.
Ctrl+1,2,4,5,9 Set zoom level to 1 second, 10 seconds, 

1 minute, 5 minutes, or 1 hour.
Left Scroll view to the left.
Right Scroll view to the right.
Page Up Scroll view to the left one page.
Page Down Scroll view to the right one page.
Home Move view to the beginning of the 

section.
End Move view to the end of the section.
Ctrl+End Move view to the end of the track.
Ctrl+Right Move the marker right.
Ctrl+Left Move the marker left.

Playback

Keystroke Action
Space Start/stop playback of view.
Shift+Space Start/stop playback of view starting at marker.
Ctrl+A Play the entire project.
Ctrl+E Plays from the marker to the end of the project.
F5, F6, F7, F8, F9 Plays view, plays from marker, plays to marker, 

stops, and moves marker respectively.

Editing

Keystroke Action
Ctrl+B Trim beginning.
Ctrl+C Copy selected sections.
Ctrl+M Mute selected sections.
Ctrl+T Trim end.
Ctrl+V Paste clipboard at marker.



Ctrl+W Show or hide waveforms or images.
Ctrl+X Cut selected sections.
Alt+Backspace or Ctrl+Z Undo last operation.
Shift+Ins Create a new track.
Shift+Del Delete the track.
Ins Add a new section.
Del Delete the section.
Ctrl+F Show or hide fade graphs.
Ctrl+P Show or hide pan graphs.



Crossfade Audio

Use the Effect | Fades command to crossfade between two sections, such as fading out one song while 
fading in another.    The figure below illustrates an example.

Crossfading

Crossfading is accomplished using the following procedure:
1) Add Sound 1 to Track 1.
2) Create a new track.
3) Add Sound 2 to Track 2.
4) Drag Sound 2 to a position so that it starts 5 seconds before the end of Sound 1.
5) Choose Fade graph from the Effect menu.
6) Shape the envelope so that the end of Sound 1 goes to 0.0 and the beginning of Sound 2 goes 

from 0.0 to 1.0, as illustrated.

Use the left mouse button to drag an existing point or add a new point.    To remove a point, drag it outside 
the section box.    Note that you cannot delete points at the very beginning or end of the section.    To clear 
all the points, use the Effect | Reset fade command.

See Also
Getting Started
Crossfade Video
Autofade



Crossfade Video

Use the Effect | Fades command to crossfade between two sections, such as fading out one video while 
fading in another.    The figure below illustrates an example.

Crossfading

Crossfading is accomplished using the following procedure:
1) Add Movie1 to Track 1.
2) Create a new track.
3) Add Movie2 to Track 2.
4) Drag Movie2 to a position so that it starts a few seconds before the end of Movie1.
5) Choose Fade graph from the Effect menu.
6) Shape the envelope so that the beginning of Movie2 goes from 0.0 to 1.0, as illustrated.    Note 

that no fading is required on Movie1.

Use the left mouse button to drag an existing point or add a new point.    To remove a point, drag it outside 
the section box.    Note that you cannot delete points at the very beginning or end of the section.    To clear 
all the points, use the Effect | Reset fade command.

The lower the point, the more transparent the video will be.

See Also
Getting Started
Crossfade Audio
Video Editing Basics



Using Plug-ins

To apply a plug-in to a section:
1) Select the section.
2) Choose the Audio plug-in or Video plug-in command from the Effect menu.
3) Check the checkbox next to the plug-in's name.
4) Choose the Properties button to adjust any other setting.
5) Choose OK.

To change a plug-in's setting for a section:
1) Select the section.
2) Choose the Audio plug-in or Video plug-in command from the Effect menu.
3) Select the plug-in you want to change.
4) Choose the Properties button and make the changes.
5) Choose OK.

To remove a plug-in from a section:
1) Select the section.
2) Choose the Audio plug-in or Video plug-in command from the Effect menu.
3) Uncheck the checkbox next to the plug-in's name.
4) Choose OK.

Some video plug-ins allow additional settings, such as start and finish values, and a mix option.    The 
Start value specifies the initial progress of a transition or transform.    In the case of a fade transform, it 
specifies how faded the video starts.    The Final value specifies the final progress of the transform or 
transition, such as how much the video should be faded.    See Video Editing Basics for additional 
information.

The Mix with master setting may be available if the plug-in accepts either 1 or 2 inputs.    The master 
window contains all the video on the lower layers.    The Pixelate transform, for example, accepts either 1 
or 2 inputs.    If you check the Mix with master setting, it uses 2 inputs: the video section where the effect 
is applied, and the master video window.    This means that it will pixelate out the video section, and 
pixelate in the master window (lower video layers).

If you do not check the Mix with master option, only a single input is used, which is the video by itself.    
In this case, the video will pixelate until the end of the section.

Audio plug-ins can be applied to audio sections only (not MIDI or CD sections).    Video plug-ins can be 
applied to video sections only.

See Also
Plug-in List
Crossfade Audio
Crossfade Video
Video Editing Basics



Timebox

A timebox lets you specify a time in a variety of ways.    The general form is HH:MM:SS.TTT.    Each 
letter represents a single number: H for hour, M for minute, S for second and T for thousandths of a 
second.    For example, 2 hours, 35 minutes and 40 seconds is given as 2:35:40.000.    However, you 
can use whatever format is easier.    You could have entered 155:40 in minutes and seconds or 9340 in 
seconds.    You can even enter 1 minute as 1: or enter 1:: for 1 hour.



Group List

Groups organize a set of sections under a single name.    A group may contain all the video sections, 
recording sections, or a set of sections that you often need to access, move, or copy.

To create a group:
1) Select one or more sections.
2) Choose Group list from the Edit menu.
3) Enter a name for the group in the top box.
4) Choose the Create button.

To reselect a group in Multiquence, either choose the group in the list and use the Select button or 
double-click on the group in the list.

To delete a group, select it from the list and use the Deletebutton.



Equalizer

The Equalizer is a flexible tool for reducing or enhancing ranges of frequencies in a sound.    If you 
wanted to boost base sounds, for example, you would increase the levels for bands 1 and 2.

Equalizer levels
The levels (or gains) for 5 frequency bands can be adjusted using the scroll bars or by entering a value in 
the appropriate edit box.    A gain of 12 dB is equalivent to an increase of 400%.    A gain of -12 dB is 
equalivent to a reduction to 25%.    A 0 gain disables the band.

Center frequencies
The center frequency specifies what frequency the band should change.    Any frequencies near the 
center are affected.    A band with a center at 1000 Hz, for example, affects frequencies between 500 Hz 
and 1500 Hz.

Setting
Check this box to enable the equalizer.

Presets
Predefined parameters can be read from presets.



Flange

Flange uses variable delays and mixing to create some unusual audio effects, including echos and 
reverbs.    Parameters can be entered by hand or read from presets.

Input
Specifies the volume of the unmodified sound to mix with the output.    A value of 100 is full volume.    The 
original sound is not mixed if the volume is 0.

Flange
Specifies the volume of the flanged sound to mix with the output.

Feedback
Specifies the volume of the feedback to mix with the output.

Invert
The input, flange, or feedback can be inverted by checking the approriate check box.    Normally, mixing 
adds the sounds together.    Checking Invert subtracts a sound instead.

Depth
Specifies in milliseconds how much the delay should vary.    A value of 40 will let the delay vary from 0 to 
40 milliseconds.

Frequency
Specifies how fast to vary the delay.    A value of 2 will vary the delay over its depth twice a second.    For a 
value of 0.2, the full delay depth is reached every 5 seconds.

Fixed delay
The fixed delay is added to the depth to change the minimum delay.    If the depth is 40 and the fixed 
delay is 10, the delay will vary from 10 to 50 milliseconds.

Setting
Check this box to enable a flange effect.



Pan

The Pan graph lets you control the left/right balance of the section.    Higher points are left, lower points 
are right.



Speed

The speed effect controls the playback speed and pitch of an audio section.    Simply adjust the scroll bar 
to the left or right to change the speed.    Note that changing the speed also changes the length and the 
pitch of the section.



Autofade

Use Autofade to automatically fade audio sections in the selected track.    This is useful if you have 
background music or sounds that must be faded when a voice section is played. You would select all the 
voice sections, select the track containing the background music (click on the track header), then use 
Autofade to automatically adjust the fade envelopes.    Note that none of the voice section may be 
located in the selected track (a section cannot fade itself).

Autofade

Sections A, B, and C are selected.    The Background section is not selected, but the track where it 
resides is selected.    The fade envelope is automatically reduced where sections A, B, and C overlap 
Background.

Several fade envelopes are provided in the presets.    You can create your own envelopes by dragging the 
four points to different    locations.

If your background sounds are in more than one track, you can select each track and apply the Autofade 
effect.

See Also
Crossfade Audio



Plug-in List

The audio and video plug-in lists show all the DirectX plug-ins installed in your system.    To apply a plug-
in to a section, check the checkbox at the left of the plug-in name.    Choose the Properties button to set 
any properties for the plug-in.
See Using Plug-ins for more information.



Find Section

Use the Find Section dialog to search for a section.    Enter the name of the section in the edit box, and 
choose OK.    If a section is found, it is selected.    Use Edit | Find next to search for the next section with 
that name.



Recorder

The Recorder window lets you record new audio.    Several Recorder windows can be active at one time 
so you can record several files at the same time provided you have multiple sound cards.    For 
synchronized recording, see Track | Create recording section.

Recorder Window

Recording, playback, and editing controls are located along the top.    Tooltips and the status bar describe 
the purpose of each button.

The source drop down list contains all the recording sources for a given sound card.    To enable a source, 
check the checkbox next to the list.    To select a different sound card, use the Device button.

The volume slider controls the volume level of the shown source.    You can adjust the volume of a 
different source by selecting it from the list.    The Monitor button activates the VU meters so you can 
adjust the volume levels to avoid clipping.    If clipping occurs, the right-most red light remains on.    You 
can stop and restart monitoring to reset the light.

Before you begin recording, you must create a new file by clicking the New button.    When you press the 
Record button, recording continues until: the stop button is pressed, there is no storage available, or an 
error occurs.

When recording stops, the waveform of the recording is shown.    You can move the marker to trim the 
beginning or end of the file using the Trim buttons.    You can also record over part of the file.    Recording 
starts at the marker's position.

When recording and editing is complete, add the file to your Multiquence project using the Add button.

See Also
Track | Create recording section



Recorder Device

Use this dialog to set the recording and playback devices for the recorder window.    If you have several 
recorder windows opened, you will need to select a different recording device for each window if you want 
all windows to be able to record at the same time.



Contents Threshold

The Contents threshold specifies the maximum amount of time shown in the view for displaying the 
contents of a file.    For audio and recording sections, the waveform is graphed.    For video sections, 
images are shown.

A value of 20 means that the contents will not be displayed unless the view is zoomed in to 20 seconds or 
closer. A value of 1 means that you would need to use View | 1 second to see the contents.    You can turn 
off contents at any time using View | Show contents.

Contents are display only if View | Show contents is checked and the range of time shown in the time 
axis is less than or equal to the threshold value.



Grid Size

The grid size specifies the amount of time between each grid line. A value of 5 means a grid line is draw 
every 5 seconds abd the marker and section will be aligned to a 5 second interval.

 Note that the View | Grid/snap to grid option must be enabled to see the grid lines.



CD Options

Use the CD Options dialog to select a playback region and caption for a CD audio section.

The Caption is any text you would like to use to describe the section.    It will be shown in the section.

Region to play
If you have multiple CD-ROM drives, you can select the drive letter from the Device list.    Make sure you 
select a drive before specifying a range in the From and To timeboxes.



Create Recording

Use the Create Recording dialog to specify the filename, length, and number of channels for a 
recording.    The length is specified in a timebox.

After the section has been added, you can use the Options | Section command to set more options, such 
as input device and input source.

Note that any existing file is erased.    A recording section is not deleted from your hard drive if you 
remove from your project.

To adjust the recording volume levels, you can use the Monitor feature under the View | Window | 
Recorder command.

See Also
Recorder Window



Recording Options

Use the Recording Options dialog (Options | Section) to change the recording length, select a record 
device, select a record source, or enable/disable recording.

Record device
If you have more than one input device installed, you can select a specific device to use for this recording 
section.    By selecting a different device for each recording section, you can record several tracks at 
once.

Record source
Most sound cards have several sources.    Select an appropriate source for your recording (such as Line-
in or Microphone).
    To adjust the recording volume levels, you can use the Monitor feature under the View | Window | 
Recorder command.

Length
If you need to to change the length of the recording, specify a new time in the timebox.

If Record is selected, the section will be recorded when the project is played.    If Play is selected, the 
section will be played when the project is played.    Use this setting to test how a recording sounds when 
combined with all the other tracks.

See Also
Recorder Window



Move

Use the Move dialog to move a section or group of sections to an exact time.    The time can be absolute, 
from the beginning of the project, or relative, from the nearest preceding section.



Audio Options

Use the Audio Options dialog (Options | Section) to select the playback region, enable looping or 
configure playback channels.

Region to play
Choose the Entire sound option if you want to play the entire file.    Choose the Part of sound option if 
you want to play only part of the file and define the region in the From and To timebox.    If the audio file 
contains any cue points, they are listed in the timebox.

If you want to loop the section, enter a non-zero value for Loops.

Channel to play
If the audio file is stereo, you can choose Left or Right to use and play only one channel.    Both channels 
are enabled if Stereo is selected.

Output channel
This option specifies the output channel for the section.    Choose Left to have all audio in the section 
played on the left channel.    Choose Right for playback on the right channel.    Choose Stereo to use 
both channels.



MIDI Options

Use the MIDI Options dialog to select the playback region.

Region to play
Choose the Entire song option if you want to play the entire file.    Choose the Part of song option if you 
want to play only part of the file and define the region in the From and To timebox.



Video Options

Use the Video Options dialog to select the playback region, configure the video position and size, or set 
transparency values.

Region to play
Choose the Entire clip option if you want to play the entire file.    Choose the Part of clip option if you 
want to play only part of the file and define the region in the From and To timebox.

Video position and size
The X and Y values set the position.    The Width and Heigth values set the size.

Preview
The preview window represents a full screen video frame.    The current position, size, and transparency 
settings are previewed.    Transparent regions are shown in green.    Use the scroll bar below the preview 
window to show different frames.

Transparent colour range

Use these setting to define a range of colours to be transparent.    This creates a blue or green screen 
special effect for compositing part of one video over another (to superimpose actors over computer 
generated backgrounds, for example).    Note: Using some video transforms may disable the transparency 
effect.

You can specify the colour range manually or simply click the mouse on the preview window over the 
colours that need to be transparent.    Make sure the Transparent colour range box is checked to see 
the effect.    Hold the Ctrl key and click on the Preview window to reset the range to a single colour.

See Also
Crossfade video
Effect | Video plug-ins



Image Options

Use the Image Options dialog to set the display time and configure the image position and size.

Display time
The display time is the length of time that the image will be shown on the video screen.

Refer to Video Options for an explanation of the other controls.

See Also
Crossfade video
Effect | Video plug-ins



Caption Options

Use the Caption Options dialog to edit the caption text, change the scrolling direction, set the display 
time, or configure the position and size.

Caption text
You can edit the caption text in this window.    Editing feature are similar to the WordPad accessory.    The 
font size, face, and justification can be changed.    Before choosing a font size, it is important to choose 
and Apply the render width and height first.

Preview
The preview window represents a full screen video frame.    The current position and size settings are 
previewed.    You can move the scroll bar to see how scrolling will behave (if enabled).    Remember to 
Apply any changes to see updated preview.

Caption position and size
The X and Y values set the position.    The Width and Heigth values set the size.

Display time
The display time specifies the length of time that the caption is shown on the video screen.    It also 
controls how fast the text will scroll, if scrolling is enabled.

Scrolling
This sets the scrolling direction for the text.

Render width and height
These set the level of detail used to render the text.    Use higher numbers for smoother text.    For best 
quality, these should be set to the width and height of the final video.    If you plan to create a standard 
MPEG-2 video, then values of 720 and 480 (or higher) should be used.    The values must be set and 
applied before writing any caption text since the size of the text changes with these values.

All video effects can be applied to caption sections, such as fading and transitions.

See Also
Crossfade video
Effect | Video plug-ins



Track Options

Use the Track Options dialog to change the selected track's name, volume, mute, and solo settings.    A 
muted track is excluded from playback and from the Save as wave and Save as video commands.    A 
solo track is played (or saved) exclusively and all other tracks are excluded.



Folder Options

Use the Folder Options dialog to choose folders for commonly used file types.    To set a folder, choose 
the button to the right of the edit box.

Audio
Specifies the folder where you keep your digital audio files (*.wav, *.aif, *.voc, *.au, etc.).

MIDI
Specifies the folder where you keep your MIDI files (*.mid, *.rmi).

Video
Specifies the folder where you keep your video files (*.avi).

Image
Specifies the folder where you keep your images (*.gif, *.jpg, *.png, *.bmp).

Project
Specifies the folder to use when saving project files.

Digital audio editor
Specifies the pathname of an audio editing application to use for the Edit | Open editor command.



Playback Options

Use the Playback Options dialog to configure output quality, media prepare time, scrolling, and output 
device.

Quality and preparation
Quality controls the sampling rate to use for playback and mixing.    Using a lower sampling rate may 
increase the number of tracks that can be played on your system, but the audio quality decreases.    If you 
receive a warning that your system is not fast enough, try using a lower sampling rate.    Later, you can 
use the File | Save as wave command to create a high quality wave file without any gaps.

Video frame rate specifies the number of frames per second for realtime video playback.    Note that if 
your system is not fast enough to play at the given frame rate, then frames will automatically be dropped. 
You can decrease this setting to reduce the amount of processing time spent on video.    Note that frames 
are not dropped when using the Save as video command.

Media prepare time specifies how much time is needed to prepare a multimedia file for playback.    This 
applies to CD audio, MIDI, recording, and video sections.    It does not apply to digital audio.    On slow 
systems, it may take a few seconds to prepare a file for playback.    If you notice that synchronization is off 
at the beginning, try adjusting this time.    Note that due to inconsistent standards and differences in 
hardware, synchronization cannot be maintained for a long period of time.    Most sound cards do not play 
at the exact given sampling rate, which makes synchronization difficult.

Options
The Scroll view to follow playback option scroll the view if the playback position moves outside the 
window.    This can be useful when zoomed in and you need to see the sections as they are played.

The Reserve 16-bit recording option ensures that a 16-bit device will be used for recording.    Some 
sound cards use 8-bit recording during 16-bit playback, causing noisy recordings. 

The Improve responsiveness option greatly improves how quickly modifications can be heard during 
playback.    Normally it takes about 800ms before mute, solo, or volume changes are heard.    Enabling 
this option reduces that lag to under 200ms. The master VU meters also update quicker, giving more 
accurate realtime levels.    This option uses more processing power, so avoid it if you use a slow system 
or notice breaks in playback. 

Audio playback device
If you have more than one audio playback device installed in your system, you can select a specific 
device from the list.    This device will be used for all digital audio output generated by Multiquence.



Tool Bar Options

Use the Track Options dialog to configure the Multiquence tool bar.    Highlighted buttons are shown in 
the tool bar and grayed buttons are not.    Click on a button to highlight or gray it.



Presets

Presets store parameters and shapes in the MQPreset.ini file so they can be recalled again the next time 
the effect is used.    Controls for presets consist of a drop down list box, a [+] button, and a [-] button.

To add a new preset:
1) Enter in all the new parameters and/or draw the new shape.
2) Type in a new name for the preset in the drop down list.    This name cannot be the same as one 

currently in the list.
3) Choose the [+] button.

To delete a preset:
1) Select the preset from the drop down list.
2) Choose the [-] button.

To change a preset:
1) Delete the preset, as above.
2) Add the preset, as above.

When you delete a preset, the current parameters and name remain on the screen so they can be 
changed.



Multiquence Order Form

Please type in the following information:

Name (first & last): ___________________________________

[Company]: _____________________________________________

Address: _______________________________________________

         _______________________________________________

         _______________________________________________

Country: _______________________________________________

E-mail address: ________________________________________

[Telephone (with Area Code)]: __________________________

Multiquence version (see Help | About): v2.02

Multiquence license/password: (US$45, Can$65, UK£30)

Payment:
    [ ] Check enclosed (payable to GoldWave Inc.)
    [ ] Money order enclosed

Please mail this form to the address below.  Thank you for
registering!

GoldWave Inc.
P.O. Box 51
St. John's, NF
CANADA  A1C 5H5

www.goldwave.com/multiquence/



Web Site Links

Main page:
http://www.goldwave.com/multiquence 

Ordering information:
http://www.goldwave.com/multiquence/register.html 



Registering

Multiquence is a shareware program.    It is not free.    To register and support further development, please 
fill in the order form or visit the website.    Registration details are given below.

Registration (US$45, Can$65, UK£30)
You will receive a personalized license that removes all shareware messages/logos and unlocks the latest 
version of Multiquence.    Please be sure to download the latest version from the Multiquence website.

Sending Payment
Checks from banks in the United States, Canada, the United Kingdom, are welcome.

An international postal money order or bank draft in Canadian currency is required for other locations. 
Make sure that you send a copy of the order form separately if it cannot be included with the money order 
or bank draft.



Multiquence Shareware Version

This application is a demonstration shareware version of the Multiquence multitrack audio processor.    
Shareware allows you to try a program before you buy it.    If you find Multiquence useful, you are required 
to register it.    Please note that the demonstration version limits saved files to 45 seconds in length.

As shareware, you can give copies of Multiquence to anyone you think might find it useful.    You can also 
upload it to websites and post it to appropriate forums or newsgroups.    Before copying, uploading, or 
posting, please click here.

Please read Getting Started for an introduction.    Additional information is given in the Contents.

The readme.txt file contains helpful information and important installation instructions.    The 
whatsnew.txt file lists many of the changes made to this version.    For recent information and software 
updates, please refer to the Multiquence website.

Toll Limit
The toll in the status bar gives you a rough idea of the benefit you have received from using Multiquence. 
This shareware version is limited to 100 commands (or a $1.00 toll) each session.    When the limit is 
reached, a toll message will appear occasionally.    Exiting and restarting Multiquence gives you another 
100 commands without messages.    By registering, you will receive a password that removes the toll limit, 
allows you to save files longer than 45 seconds, and create videos without the Multiquence logo.



Only the original Multiquence zip file may be copied, uploaded, or posted.    This ensures that everyone 
will get a complete and working copy.    Distributing modified or incomplete copies is a violation of the 
copyright.






